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Introduction to Citizen Problem Reporter 

Citizen Problem Reporter can be used to solicit non-emergency problem reports (for example, blight, 
graffiti, trash, potholes, clogged drains, and flooding) from the general public. 

It provides 24/7 access to an organization and the location-enabled problem reports helps efficiently 
triage reports to the correct person or department responsible for its resolution. This accelerated 
approach improves the quality of life in a community and reduces long-term asset maintenance costs. 
Citizen Problem Reporter is typically implemented by planning departments, public works agencies, 
utilities, and other local government organizations that want to take a data-driven approach to asset 
maintenance or code enforcement. 

The Citizen Problem Reporter solution delivers a set of capabilities that help you solicit reports from the 
public, manage the response to each report, solicit feedback from the public after addressing a report, 
and monitor the resolution of nonemergency reports in a community. 

Requirements 

Citizen Problem Reporter requires the following: 

• ArcGIS Online 

• ArcGIS Survey123 Connect 

Information products 

Citizen Problem Reporter includes the following information products: 

Item Description Minimum user type 

Citizen Problem 
Center 

An ArcGIS Hub site used by the general public to learn 
how they can report a nonemergency problem to help 
improve the community 

Not required 

Citizen Problem 
Reporter 

A Crowdsource Reporter app used by the general 
public, or local government personnel, to submit 
nonemergency problems in their community 

Editor (required for 
government personnel 
only) 

Citizen Problem 
Satisfaction Survey 

An ArcGIS Survey123 form used by the general public to 
report their satisfaction regarding the service 
requested 

Not required 

Volunteer in Your 
Neighborhood 

An ArcGIS Survey123 form used by the general public to 
volunteer to help their community 

Not required 

Citizen Problem 
Manager 

A Crowdsource Manager app used by local government 
personnel to triage submitted problem reports and 
update the status of each report as needed 

Editor 

Citizen Problem 
Dashboard 

An ArcGIS Dashboards app used by local government 
personnel to monitor nonemergency problems 
submitted by the general public 

Viewer 

When you deploy this solution in your ArcGIS organization, you also get an ArcGIS Solution item that 
organizes the key information products and summarizes all the ArcGIS items (applications, forms, 
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projects, maps, feature layers, feature layer views, and so on) included with the solution. The ArcGIS 
Solution item also illustrates any dependencies items have on each other. 

Release notes 

The following are the release notes: 

Version Description 

1.0 • First release of Citizen Problem Reporter 
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Configure Citizen Problem Reporter 

Learn how to configure the Citizen Problem Reporter solution to meet specific needs in your 
organization. The first three sections will guide you through adding a new problem category, modifying 
existing problem types and agencies, and revise existing survey questions. The last section guides you 
through extending the app to generate report IDs, moderate reports, send email notifications and enrich 
reports. 

Add a new problem category 

The Citizen Problem Reporter app allows the public to submit nonemergency problem reports. Problem 
reports are grouped into categories that make it easier to submit a report. The problem categories 
appear when a user signs in to the app and are stored in the CitizenProblems feature layer and 
visualized in feature layer views. 

Citizen Problem Reporter includes nine problem categories: Animal, Blight, Health, Land Use, Park/Tree, 
Road, Snow/Ice, Trash, and Utility. In some cases, you may want to add a problem category to Citizen 
Problem Reporter to meet your organization’s needs. 

Add problem category 

Review the CitizenProblems feature layer categories and identify what categories your organization may 
want to add or remove from the Citizen Problem Reporter app. 

• Sign in to your ArcGIS organization and browse to your CitizenProblems feature layer. 

• Open the item page and click the Data tab. 

• Click Fields. 

• Click the Category display name. 

  In the List of Values (Domain) section, review existing categories and identify ones that are not 
applicable and ones that are missing. 

• Click Edit next to List of Values (Domain). 

• Optionally, click the Delete button to remove a category from the list. 

• Optionally, click Add. 

• Type the new category name into the Displayed Value and Stored Value text boxes. 

• Repeat steps 7 and 8 to add the remaining missing categories. 

• Optionally, drag the category to a new location in the list to reorder them. 

• Click Save. 

Create feature layer view 

Create a feature layer view of each new category added to the CitizenProblems feature layer. 

• In your browser, click the Overview tab. 

• On the CitizenProblems feature layer item page, click Create View Layer. 

• Type the name of the category in the Title text box—for example, CitizenProblems_animal. 

• Type tag terms separated by commas. 
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• Type a summary in the Summary text box—for example, A public view of <insert 
category name> problems reported by the public through focused citizen 
engagement apps. 

• Save the feature layer view in the Citizen Problem Reporter folder. 

• Click OK. 

  Update the editing setting, so the public can submit nonproblem reports with the Citizen Problem 
Reporter app. 

• On the item page, click the Settings tab. 

• Scroll to the Feature Layer (hosted, view) section and check the Enable editing check box. 

• Uncheck the Delete check box under the What kind of editing is allowed setting. 

• Click Save. 

  Set the view definition so the public sees the new problem report category. 

• Click the Overview tab. 

• Click Open in Map Viewer Classic. 

• On the new category layer, click More Options, and click Set View Definition > Define Features. 

• Create the following expression: Category is new category. 

• Click Add another expression and create the following expression: Visible to the public is Yes. 

  By default, all problem reports submitted using the Citizen Problem Reporter automatically set the 
Public View field to Yes, making it visible to the public. You can manually set the visibility to No 
using the Citizen Problem Manager when triaging the issue. 

• Click Apply Definition. 

• On the new category layer, click More Options, and click Show Item Details. 

• Close the new category map tab. 

• On the item page, click the Data tab. 

• Click Fields. 

• Click the Type of Problem display name. 

Install add-in 

To add a problem category using the Modify Domain tool, install the ArcGIS Solutions Deployment Tool 
Add-In. If you already installed the add-in, you do not need to install it again. 

Note: 

The current version of the ArcGIS Solutions Deployment Add-In is 2020.7.28. Ensure you have the most 
recent version of the add-in installed before proceeding. 

• Download the ArcGIS Solutions Deployment Tool .zip file. 

• Close ArcGIS Pro before installing the add-in. 

• Browse to the folder to which you downloaded the .zip file and extract its contents. 

https://links.esri.com/download/ArcGISSolutionDeployment/
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• Double-click SolutionDeployment.esriAddInX to run the installer. 

• Click Install Add-In.  

• After installation is complete, click OK. 

  Note: 

  The current version of the ArcGIS Solutions Deployment Add-In is 2020.7.28. Ensure you have the 
most recent version of the add-in installed before proceeding. 

Add problem type domain 

Add a problem type domain for the new problem report category. 

• Open ArcGIS Pro and create a new project. 

• Sign in to the ArcGIS organization to which you deployed the Citizen Problem Reporter solution. 

• On the Share tab, in the Deploy group, click ArcGIS Solutions. 

• Double-click Configure an ArcGIS Solution task. 

• On the Configure an ArcGIS Solution step, click Next Step. 

• On the Add Fields step, click Skip. 

• On the Modify Domains step, click the browse button next to the Input Layer or Table parameter. 

  The Input Layer or Table dialog box appears. 

• Under Portal, click My Content. 

• Double-click the Citizen Problem Reporter folder. 

• Double-click the new category feature layer view. 

• Click Citizen Problems, and click OK. 

• In the Field parameter, click the drop-down arrow and choose Type of Problem. 

• In the Type parameter, click the drop-down arrow and choose Coded Value. 

• Type the category name in the Name text box—for example, Animal. 

• In the Domain section, type a new category in the Code text box and in the Description text box. 
Repeat this step until all the domains that apply to your organization have been added. 

• Once you have finished adding domains, click Run. 

• Click Finish. 

• Close ArcGIS Pro and save your changes. 

• In your browser, refresh the Type of Problem page. 

• Click Fields. 

• Click the Type of Problem display name. 

Under the List of Values (Domain), you see the newly added domains. The domains added appear in the 
Type of Problem drop-down list in the Report a problem form. 
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Repeat the steps in this section for each new category you want to add to your Citizen Problem Reporter 
app. Once you have finished adding new categories, you will create a map for each category. 

Create a map 

Each problem category displayed in the Citizen Problem Reporter app is a single map. Create a map for 
each category you want to add to your Citizen Problem Reporter app. 

• Click the Apps button in the header of the site and click Map Viewer Classic. 

• Click the Add button and choose Search for Layers. 

• Type the name of a category feature layer view in the search box. 

• Click the Add button  on the layer result. 

• Click the Back button. 

• Click the Content button. 

• On the new category layer, click More Options, and click Rename. 

• Type the category name in the Layer Name text box—for example, Animal Problems. 

• Click OK. 

  Create feature templates for each new problem report category. 

• On the layer, click Change Style. 

• Click the Choose an attribute to show drop-down arrow and choose Show location only. 

  A warning window appears, informing you the changes made to the symbology will affect the 
symbols displayed. Add and update the symbology once you have created a feature template for 
your new category. 

• Click Yes. 

• Click Done. 

• Click the Edit button. 

• Click Manage. 

• Click the New Feature drop-down arrow and choose Properties. 

• Type the category name and – Submitted in the Name text box—for example, Animal 
Problems - Submitted. 

• Click the Category drop-down arrow and choose the new category. 

• Click Done. 

• Click Save Changes. 

• Click the Close button. 

Change style 

Update the symbology to reflect your new problem report category. 

• Click the Details button. 

• On the layer, click Change Style. 



7 

 

• Click the Choose an attribute to show drop-down arrow and choose Status. 

  A warning window appears, informing you the changes made will affect the symbols displayed. 

• Click Yes. 

• Click Options. 

• Click the Submitted symbol. 

• Click Shape. 

• Click the drop-down arrow and choose a symbol set or Custom Images. 

• If you chose to add a symbol from a symbol set, click a symbol and set the symbol size, click OK. 

  Tip: 

  If you chose a symbol from the Government symbol set, set the symbol size to 21 px. 

• If you chose to add a custom image, click Use an Image, paste a URL in the text box, set a symbol 
size, and click OK. 

• Repeat steps 6 through 8 and assign symbols for the remaining category statuses. 

• Optionally, click the symbol options button to drag and reorder the symbols. 

• Click OK. 

• Click Done. 

Update the pop-up 

Update the pop-up on the new problem report layer. 

• On the layer, click More Options, and click Configure Pop-up. 

• Enter a title for your pop-up by clicking the [+] button and choosing the Type of Problem field. 

• Click Configure. 

• Click the View HTML Source button in the editor. 

• Delete the existing HTML code. 

• Copy and paste the following HTML code: 

  {category} problem reported on {CreationDate}.<br /><br /> 
<b>Details:</b> {details}<br /><br /> <b>Status:</b><br /> <table 
style="border-collapse: separate; border-spacing: 2px 4px; width: 100%; 
table-layout: fixed; margin: 0px -2px; max-width: 350px;"> <tbody><tr 
height="16"> <td style="{expression/expr0}; text-align: center; width: 
25%"></td> <td style="{expression/expr1}; text-align: center; width: 
25%"></td> <td style="{expression/expr2}; text-align: center; width: 
25%"></td> <td style="{expression/expr3}; text-align: center; width: 
25%"></td> </tr> <tr height="24" style="text-align: center;"> <td 
style="text-align: center; width: 25%; font-weight: normal; padding-left: 
0px; word- wrap: break-word;">Submitted</td> <td style="text-align: 
center; width: 25%; font-weight: normal; padding-left: 0px; word- wrap: 
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break-word;">Received</td> <td style="text-align: center; width: 25%; 
font-weight: normal; padding-left: 0px; word- wrap: break-word;">In 
Progress</td> <td style="text-align: center; width: 25%; font-weight: 
normal; padding-left: 0px; word- wrap: break-word;">Completed</td> </tr> 
</tbody></table> <table style=" border-collapse: separate; border-
spacing: 0px 0px; width: 100%; table-layout: fixed; margin: 0px -1px;"> 
<tbody><tr> <td style="display:{expression/expr4}; text-align: left; 
width: 100%"> <b><br />Resolved On:</b> {resolutiondt}<br /><br /> 
<b>Resolution:</b> {resolution} </td> </tr></tbody> </table> 

• Click the View HTML Source button in the editor. 

• Click OK. 

• Click the Configure Attributes link. 

• Click the Edit check box, and uncheck the check box. 

• Click the Display check box and uncheck the check box. 

• Click the Display check box next to the following fields: {probtype}, {status}, {details}, 
{expression/expr0}, {expression/expr1}, {expression/expr2}, {expression/expr3}, and 
{expression/expr4}. 

  Display fields are displayed in the Report a problem form. 

• Check the Edit check box next to the following fields: {probtype}, {details}, {pocfullname},{pocmail}, 
and {pocphone}. Ensure {pocfullname}, {pocmail}, and {pocphone} display check box is unchecked, 
so this information isn’t publicly visible. 

  Edit fields are editable in the form, so when the public submits a problem report, the information is 
written to the editable fields. 

  Optionally, you can choose to use the {pocfirstname} and {poclastname} fields in your Report a 
problem form instead of the {pocfullname} field. If you choose to, the First Name and Last Name 
parameters appear in the form instead of Full Name. 

• Click the {details} field row. 

• Click the Textbox Type drop-down arrow and choose Multiple Line. 

• Rename the {details} field alias to Problem Details. 

  The details field (in the Report a problem form) is renamed to Problem Details and the text box 
has doubled in size, so users can add more information about the problem they are submitting. 

• Reorder the fields in the following order: {probtype}, {details}, {pocfullname}, {pocphone}, 
{pocmail}, {status}. To reorder the fields, click the field name and use the Move up and Move 
down arrows. 

  The order of the fields in the Configure Attributes window reflects the order of the questions in 
the Report a problem form. 

• Add a colon after the following Field Alias values: Type of Problem, Problem Details, Full Name, 
Phone Number, Email, and Status. 

• Click OK. 
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• Check the Show feature attachments as links check box. 

• Uncheck the Show when last edited check box. 

• Under Attribute Expression, press the Shift key and click the Resolution Time and Full Name 
expressions. 

• Click the Remove expression button. 

  The Resolution Time and Full Name Arcade expressions persisted when you created the category 
feature layer view from the CitizenProblems feature layer. These Arcade expressions are not used 
in the Citizen Problem Reporter app. 

  The first four expressions define the color used in the status bar in the layer pop-up as well as in 
the problem details in the Citizen Problem Reporter app. The status bar updates as the problem 
reported status is updated to Submitted, Received, In Progress, and Completed. 

  The last Arcade expression is configured to only display the Resolved On date and Resolved fields 
and information in the pop-up and problem details if the status is set to Completed. 

• Click OK. 

Configure the pop-up 

Configure the Comments table pop-up. 

• On the Comments table, click More Options, and click Rename. 

• Rename the table to Comments. 

• Click OK. 

• On the Comments table, click More Options, and click Configure Pop-up. 

• Delete the pop-up title. 

• Click Configure Attributes link. 

• Click the Edit check box, and uncheck the check box. 

• Click the Display check box, and uncheck the check box. 

• Click the Display check box next to the {comments} field. 

  Display fields are displayed in the Citizen Problem Reporter comment form. 

• Check the Edit check box next to the following fields: {comments}, {pocfullname}, {pocphone}, and 
{pocemail}. Ensure that {pocfullname}, {pocmail}, and {pocphone} display check box is unchecked, 
so your citizen information isn’t publicly accessible. 

  Edit fields are editable in the comment form, so when citizens make comments about a problem 
report, the information is written to the editable fields. 

  Optionally, you can choose to use the {pocfirstname} and {poclastname} fields in your Report a 
problem form instead of {pocfullname} field. If you choose to, the First Name and Last Name 
parameters appear in the form instead of Full Name. 

• Click the {comments} field row. 

• Click the Textbox Type drop-down arrow and choose Multiple Line. 
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• Rename the {details} field alias to Leave a comment. 

  The comment field (in the form) is renamed to Leave a comment and the text box has doubled in 
size, so users can add more information about their comment. 

• Change Phone Field Alias to Phone Number. 

• Add a colon after the following Field Alias values: Leave a comment, Full Name, Phone Number, 
and Email. 

• Click OK. 

• Uncheck the Show when last edited check box. 

• Click OK. 

• On the Surveys table, click More Options, and click Remove. 

• Click Yes, Remove Table. 

Save the map 

Save the new problem category map. 

• Click Save > Save As. 

• Type a title—for example, Animal Problems. 

• Type tags that describe your map. 

• Provide a summary that describes the map—for example, A map used to report animal 
concerns in our community. 

• Save the map in the Citizen Problem Reporter folder. 

• Click Save Map. 

• Click Share. 

• Check the Citizen Problem Reporter check box. 

• Click Cancel to update sharing. Do not share the feature layer view to the Citizen Problem Reporter 
group. 

• Click Done. 

• Click the About button. 

• Click the More Details link. 

• Close the new category map tab. 

• On the item page, click Edit Thumbnail, and upload an image for the new category map. 

  Repeat the steps in this section for each new category you want to add to your Citizen Problem 
Reporter app. In addition, you can view your new problem report category, or categories, in the 
Citizen Problem Reporter app. 

• At the top of the site, click Content. 

• On the My Content tab, under Folders, type Citizen Problem Reporter in the search box. 

• Click the Citizen Problem Reporter folder. 
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• Under Item Type, click Apps. 

• On the right side of the page, click the Citizen Problem Reporter app. 

• On the item page, click View Application. 

• If you haven’t shared the Citizen Problem Reporter app and all the maps referenced in the app 
publicly, choose Sign in with ArcGIS. 

  You see the new category or categories in the app. 

• Click a new category and click Submit Problem. 

• Click the Type of Problem drop-down arrow to see the type of problem domains you added in 
ArcGIS Pro. 

Once you finished reviewing the Citizen Problem Reporter app, close the tab. 

Add problem category symbology 

Add new problem category symbology. 

• At the top of the site, click Content. 

• On the My Content tab, under Folders, type Citizen Problem Reporter in the search box. 

• Click the Citizen Problem Reporter folder. 

• Under Item Type, click Layers. 

• On the right side of the page, click the CitizenProblems layer. 

• On the item page, click Open in Map Viewer Classic. 

• On the layer, click Change Style. 

• Click the Choose an attribute to show drop-down arrow and choose Category. 

  A warning window appears, informing you the changes made to the symbology will affect the 
symbols displayed. 

• Click Yes. 

• Click Options. 

• Click the Animal symbol. 

• Click Shape. 

• Click the drop-down arrow and choose the Government symbol set. 

  All category symbols except for the new category you created are available in the Government 
symbol set. 

• Browse to the Animal symbol  and type 21 in the Symbol Size text box. 

• Click OK. 

• Repeat steps 11 through 15 to symbolize the remaining categories. 

• Optionally, click the symbol options button to drag and reorder the symbols. 

• Click OK. 
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• Click Done. 

• On the layer, click More Options, and click Save Layer. 

  Repeat the steps in this section to update the CitizenProblems_dashboard feature layer view 
symbology. 

• Click the Add button and choose Search for Layers. 

• Type CitizenProblems_dashboard feature layer view in the search. 

• Click the Add button on the layer result. 

• Click the Back button. 

• Repeat steps 7 through 20 to apply symbols to the CitizenProblems_dashboard feature layer view. 

  Tip: 

  You can restore the original CitizenProblems symbols, as well as adding new category symbols, 
by adding a point to the map with every category and status combination. 

Add category features 

Add new problem features to the map and save them to the problem category and 
CitizenProblem_dashboard layer view. 

• Click the Edit button. 

• In the Add Features pane, click the Animal feature and add a point to the map. 

• In the pop-up, click the Status drop-down arrow and choose Submitted, and then click Close. 

• Repeat this step to add a point symbol for Animal Received, Animal In Progress, and Animal 
Completed because it already exists. 

• Repeat step 2 and 3 to add the remaining category status to the map. 

• Once all the category and status point combination have been added to the map, click the Close 
button. 

• On the CitizenProblems layer, click Change Style. 

• Click the Choose an attribute to show drop-down arrow and choose New Expression. 

• Copy the following expression and paste it in the text box: 

  return $feature.category + " " + $feature.status 

• Click OK. 

• Click Options. 

• Click Ungroup to ungroup the remaining categories. 

• Click the Animal Completed symbol. 

• Click Shape. 

• Click the drop-down arrow and choose the Government symbol set. 
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• Choose the Animal Problems - Completed symbol and type 21 in the Symbol Size text box. Click 
OK. 

• Repeat step 13 through 16 for the remaining symbols. 

  All category symbols except for the new category you created are available in the Government 
symbol set. 

• Optionally, click the symbol options button to drag and reorder the symbols. 

• Click OK. 

• Click Done. 

• On the CitizenProblems layer, click More Options, and click Save Layer. 

• Repeat steps 7 through 21 to apply the original and new category symbology to the 
CitizenProblems_dashboard feature layer view. 

• Click the Edit button. 

• In the map, click one of the points and scroll to the bottom of the pop-up and click Delete. Repeat 
this step to delete the remaining points. 

• Click the Close button. 

View new category 

View new categories in the Citizen Problem Manager and Citizen Problem Dashboard map. 

• At the top of the site, click the Home drop-down arrow and choose Content. 

• On the My Content tab, under Folders, type Citizen Problem Reporter in the search box. 

• Click the Citizen Problem Reporter folder. 

• Under Item Type, click Maps. 

• On the right side of the page, click the Citizen Problem Manager map. 

• On the item page, click Open in Map Viewer Classic. 

• Click Yes, open the map. 

• Click the Legend button and review the symbology. 

Repeat steps 1 through 7 to review the symbology in the Citizen Problem Dashboard map. 

Add or remove problem category indicator 

Add or remove a category indicator in the Citizen Problem Dashboard app. 

• At the top of the site, click the Home drop-down arrow and choose Content. 

• On the My Content tab, under Folders, type Citizen Problem Reporter in the search box. 

• Click the Citizen Problem Reporter folder. 

• Under Item Type, click Apps. 

• On the right side of the page, click the Citizen Problem Dashboard app. 

• On the item page, click Edit Dashboard. 
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  On the Overview tab, not all the problem categories may apply to your community; you can add 
new category indicator or indicators to your dashboard. 

• To add a new indicator, hover over the upper corner of the Animal Control indicator and choose 

Duplicate Element . 

• Hover over the new indicator upper corner and choose Configure . 

• In the Value area, under Filter, click the Value drop-down arrow and choose a new category. 

• Scroll down to the Reference area, under Filter, click the Value drop-down arrow and choose a 
new category. 

• Click the Indicator tab, in the Style for value at or above reference area, type a new category in 
the Top Text text box. 

• In the Style for value below reference area, type a new category in the Top Text text box. 

• Click the General tab and type a new indicator name in the Name text box. 

• Click Done. 

• Hover over the new indicator in the upper corner and choose Drag item . 

• Press the Shift key on your keyboard while dragging the item to group as a column. Dock the 
indicator next to an existing indicator. 

• Optionally, to delete an indicator, hover over the upper corner of the indicator you want to delete 

and choose Delete . 

• Click Save to save changes made to the dashboard and close the dashboard. 

Modify problem types and responsible agencies 

Citizen Problem Reporter includes problem types and responsible agencies for each problem category. 
In some cases, you may want to add a problem type to an existing category or add a new problem type 
for any new problem category you created. In addition, you may want to modify the responsible 
agencies provided to more accurately reflect the name of the agency, department, or team that is 
responsible for responding to problem reports. 

• At the top of the site, click Content. 

• On the My Content tab, under Folders, type Citizen Problem Reporter in the search box. 

• Click the Citizen Problem Reporter folder. 

• Under Item Type, click Layers. 

• On the right side of the page, click the feature layer view you want to modify—for example, 
CitizenProblems_Animal. 

• On the item page, click the Data tab. 

• Click Fields. 

• Click the Type of Problem display name. Review List of Values (Domain). Identify domains that are 
missing or need to be removed from the list. 

• Open ArcGIS Pro. 
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• Sign in to the ArcGIS organization to which you deployed the Citizen Problem Reporter solution 
template. 

• On the Share tab, in the Deploy group, click ArcGIS Solutions. 

• Double-click the Configure an ArcGIS Solution task. 

• On the Configure an ArcGIS Solution step, click Next Step. 

• On the Add Fields step, click Skip. 

• On the Modify Domains step, click browse next to Input Layer or Table parameter. 

  The Input Layer or Table dialog box appears. 

• Under Portal, click My Content. 

• Double-click the Citizen Problem Reporter folder. 

• Double-click the new feature layer view. 

• Click Citizen Problems, and click OK. 

• In the Field parameter, click the drop-down arrow and choose Type of Problem. 

• In the Domain section, optionally, to delete a domain, hover to the left of the domain you want to 
delete and click remove. Repeat this step until all the domains that do not apply to your 
organization have been removed. 

• Optionally, to add a new domain, type a new category in the Code text box, and then type it in the 
Description text box. Repeat this step until all the domains that apply to your organization have 
been added. 

• Optionally, to modify an existing domain or domains, click in the Code text box and type a new 
problem type, and click in the Description text box and type a new problem type. 

• Once you have finished modifying domains, click Run. 

• Click Finish. 

• Close ArcGIS Pro and save your changes. 

View new problem type 

View new problem type in the Citizen Problem Reporter app. 

• In your browser, refresh the Type of Problem page. 

• Click Fields. 

• Click the Type of Problem display name. 

  Under List of Values (Domain), you see the newly added or removed domain or domains. 

  Repeat the steps in this section for each problem type you want to add or modify in your Citizen 
Problem Reporter app. 

• At the top of the site, click Content. 

• On the My Content tab, under Folders, type Citizen Problem Reporter in the search box. 

• Click the Citizen Problem Reporter folder. 
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• Under Item Type, click Apps. 

• On the right side of the page, click the Citizen Problem Reporter app. 

• On the item page, click View Application. 

• Sign in to the app using Sign in with ArcGIS. 

• Click the category for which you modified the problem types, and then click Submit Problem. 

• In the Report a problem form, click the Type of Problem drop-down arrow and you see the 
updated type of problem domains. 

  Once you finished reviewing the Citizen Problem Reporter app, close the tab. 

  Now, review the list of responsible agencies and modify them to meet the needs of your 
organization. 

• At the top of the site, click Content. 

• On the My Content tab, under Folders, type Citizen Problem Reporter in the search box. 

• Click the Citizen Problem Reporter folder. 

• Under Item Type, click Layers. 

• On the right side of the page, click the CitizenProblems feature layer. 

• On the item page, click the Data tab. 

• Click Fields. 

• Click the Assigned To display name. 

  Review existing agencies and identify missing ones in the List of Values (Domain) section. 

• Click Edit next to List of Values (Domain). 

• Optionally, click Add. 

• Type the new agency name in the Displayed Value and Stored Value text boxes. 

• Repeat steps 22 and 23 to add the remaining missing agencies. 

• Optionally, click Delete to remove an agency. 

• Optionally, click in the Label text box with an existing agency labeled and change the agency name. 
Repeat this step to change the Code as well. 

• Optionally, drag the category to a new location in the list to reorder them. 

• Click Save. 

Share Citizen Problem Reporter maps and app 

For the Citizen Problem Reporter app to be publicly accessible through guest and social media access, 
the maps and layers must be shared with everyone. Follow the steps below to share your maps and 
layers with everyone. 

• Click Groups at the top of the site. 

• Open the Citizen Problem Reporter group page and click View all group content. 
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  Note: 

  Review the maps shared to the group. The maps shared to this group will be displayed in the 
Citizen Problem Reporter app. 

• Optionally, add a map or maps to the group by clicking the Add items to group and browse to the 
map or maps. Check the check box next to the map or maps you want to add to the group and click 
Add items. 

• Optionally, remove a map or maps from the group by checking the check box next to the map and 
click Remove from group. 

• Click the Settings tab. 

•  Under Who can view this group, click Everyone (public), and click Save. 

• Click Content at the top of the site. 

• On the My Content tab, under Folders, type Citizen Problem Reporter in the search box. 

• Click the Citizen Problem Reporter folder. 

• Under Item Type, click Maps. 

• On the right side of the page, check the check box next to the maps you want to appear in the 
Citizen Problem Reporter app, and click Share. 

  Tip: 

  Share maps with the word problems in the map name. 

• In the Share window, click Everyone (public) and click Save. 

• In the Update sharing window, click OK. 

  Note: 

  The layers associated with the maps should also be shared publicly. 

• Next to Item Type, click Clear. 

• Under Item Type, click Apps. 

•  On the right side of the page, click the Citizen Problem Reporter app. 

•  On the item page and click Share. 

• In the Share window, click Everyone (public) and click Save. 

• Click View Application. 

• Sign in to the app using one of the sign in options and review the app. 
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Sharing solution items 

Several layer views, maps and apps included in the Citizen Problem Reporter solution must be shared 
with everyone so they can be accessed by the public on the Citizen Problem Center site. To share your 
citizen problem reporter items with everyone, use the guide below and complete the following steps: 

• Verify that you are signed in to your ArcGIS organization and browse to the Citizen Problem 
Reporter folder. 

• Check the check box next to each of the items below: 

  Item   Name 

  Feature Layer (hosted, view)   CitizenProblems_public 

  Feature Layer (hosted, view)   Volunteers_public 

  Web Map   Citizen Problem Center Reports 

  Form   Volunteer in Your Neighborhood 

  Hub Site Application   Citizen Problem Center 

  Hub Initiative   Citizen Problem Center 

  Note: 

  You will only have a Hub Initiative item if your organization has ArcGIS Hub Premium. 

• Click Share. 

•  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you are sharing 
editable layers publicly. 

• Click Update. 

Revise satisfaction survey questions 

The Citizen Problem Satisfaction Survey allows you to solicit feedback from the public that helps you 
improve your community’s customer service. The survey includes six questions. In some cases, you may 
want to add, or remove, questions from the survey. 

• Install ArcGIS Survey123 Connect. 

• Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

• Click Citizen Problem Satisfaction Survey to download the survey. 

• In the Download window, click Download and click OK. 

• Click Citizen Problem Satisfaction Survey again to open the survey. 

• On the side toolbar, click the Open XLSForm Spreadsheet button. 

• In the Microsoft Excel spreadsheet, click the choices tab. 

  This tab comprises all the selectable options for survey questions. 

https://www.esri.com/en-us/arcgis/products/arcgis-survey123/resources
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• Click the survey tab. 

  This tab comprises all the questions in the survey. 

• Revise the survey to reflect your needs. 

• Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

• In ArcGIS Survey123 Connect, click Publish on the side toolbar to publish your changes. 

•  Click Publish survey to publish your changes and click OK. 

Extend Citizen Problem Reporter 

You can extend the Citizen Problem Reporter solution with a set of Python tools that can be used to 
generate report IDs, moderate reports, send email notifications, and enrich reports. These tools can be 
executed automatically via Task Scheduler and as new problem reports are submitted or updated the 
corresponding action occurs. 

Add the ServiceFunctions toolbox 

The ServiceFunctions toolbox contains tools for generating report IDs, moderating reports, sending 
email notifications, and enriching reports. Download and add the ServiceFunctions toolbox to your 
ArcGIS Pro project before configuring the appropriate tools. 

• Download the ServiceFunctions toolbox. 

• Browse to the ServiceSupport.zip file and unzip the file to the location from which you want 
to the tools to execute. 

• Open ArcGIS Pro and create a new project. 

• Sign in to the ArcGIS organization to which you deployed the Citizen Problem Reporter solution, if 
necessary. 

• On the View tab, in the Windows group, click the Catalog pane, if necessary. 

• In the Catalog pane, right-click Toolboxes and choose Add Toolbox. 

  The Add Toolbox dialog box appears. 

• Browse to the ServiceSupport folder. 

• Click the ServiceSupport.pyt Python toolbox, and click OK. 

• In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

  If you've never used the ServiceSupport toolbox before, run the Define Connection Settings tool to 
establish a connection between the toolbox and the CitizenProblem feature layer. 

• In the Catalog pane, in the ServiceSupport.pyt Python toolbox, double-click the Define Connection 
Settings tool. 

• In the ArcGIS Online organization or ArcGIS Enterprise portal URL parameter, click the drop-down 
arrow and choose a URL. 

• In the Username parameter, type your user name for the organization you chose in step 11. 

• In the Password parameter, type your password for the user name provided in the Username. 

https://links.esri.com/download/servicefunctions/
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• Click Run. 

Generate report IDs 

Many workflows require you to generate a unique identifier when a feature or record is created so it can 
be referenced and tracked in other workflows. You can use the Generate IDs tool to configure custom 
unique identifiers that will be applied to features at a regularly scheduled interval of your choosing. The 
tool only generates the configuration; you must run an additional script (provided) to update the 
features with incrementing identifier values. 

• In the Catalog pane, expand Toolboxes and ServiceSupport.pyt, if necessary. 

• Double-click the Generate IDs tool. 

• In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

• Under Portal, click My Content. 

• Double-click the Citizen Problem Reporter folder. 

• Double-click the CitizenProblems feature layer. 

• Click Citizen Problems, and click OK. 

  Expand General Identifier Settings. If the tool has not been run previously, start by specifying at 
least one identifier sequence. 

• In the Sequence Name parameter, type a name for the sequence. 

  This value appears in the drop-down menu for selecting the sequence to assign to each layer. 

• In the Pattern parameter, type a pattern to use for the sequence. 

  This can be a combination of letters, numbers, and symbols. Mark the location for the 
incrementing value with a pair of curly braces {}. Python formatting is applied to the pattern text, 
so string formatting syntax such as {0:03d} pads the incrementing number section with zeros to a 
length of 3. For example, the expression seq-{0:05d} creates the following pattern of values: seq-
00001, seq-00002, seq-00003, and so on. 

• In the Next Value parameter, type a value. 

  When initially creating the sequence, this must be the first value in the identifiers. After this point, 
this value shows the value to be used for the next identifier generated. 

• In the Interval parameter, type a value. 

  The interval by which the identifier values increase between features. For example, an initial Next 
Value of 1 and an Interval of 10 creates identifiers with the incrementing values of 1, 11, 21, and so 
on. 

  Deleting or changing these sequences impacts all the layers that are configured to use the edited 
sequences. 

• Optionally, edit the identifier configuration and run the tool to overwrite the existing identifier 
configuration for the selected layer. 
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  Note: 

  If an identifier configuration already exists, a check box appears that, when checked, deletes the 
existing identifier configuration for the selected layer. 

• Choose the moderation list to use to process the features in the selected layer. 

• Choose the sequence to use to generate the identifiers for each feature in the layer. 

• Choose a text field to store the generated identifier. 

• Click Run to write out the identifier configuration for the layer and any changes to the identifier 
sequences. 

• To configure identifiers for another layer, rerun the tool with the settings for the next layer. 

General Identifier Settings are not specific to any one layer—they apply to all layers configured using 
this tool. 

Moderate reports 

Public comment apps can occasionally generate feedback that should not be made publicly visible. Data 
entered into specific fields, such as personal information, can be hidden and protected using the pop-up 
configuration and layer security, but sometimes entire comments need to be hidden to avoid displaying 
sensitive or explicit content to other users. 

You can hide features by updating the value of a field so that it no longer meets the requirements of a 
filter applied to that layer in the map. You can use the Moderate Reports tool to configure which layers 
and fields to scan for explicit or sensitive words and phrases and how to update the feature so that it 
can be filtered from the map. You can choose how often to scan features and records. The tool only 
generates the configuration; an additional script (provided) must be run to scan the features. 

• In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

• Double-click the Moderate Reports tool. 

• In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

• Under Portal, click My Content. 

• Double-click the Citizen Problem Reporter folder. 

• Double-click the CitizenProblems feature layer. 

• Click Citizen Problems, and click OK. 

  Expand General Moderation Settings. If the tool has not been run previously, start by specifying at 
least one moderation list. 

• In the List Name parameter, type a name. 

  This value appears in the drop-down menu for selecting the moderation list use when scanning 
each layer. 

• In the Filter Type parameter, click the drop-down arrow and choose to scan feature for words and 
phrases that exactly match the provided list of words and phrases. 
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  For example, when the filter type is EXACT, if the list contains the word duck, the script updates 
the specified field when the feature contains the word duck, but not when it contains the word 
duckling. When the filter type is FUZZY, the script updates the feature when either duck or duckling 
are found. 

• In the Words and Phrases parameter, type a word or phrase. Provide a comma-separated list of 
words or phrases to scan for. 

  Keep in mind that deleting or changing these lists will impacts all the layers that are configured to 
use the edited sequences. 

• If a moderation configuration already exists for the selected layer, choose to edit an existing 
configuration by selecting the name of the moderation list used in the configuration, or choose the 
option to add a new moderation configuration. 

  If you choose to edit an existing configuration, a check box appears that, when checked, deletes 
the existing moderation configuration for the selected layer. Alternatively, edit the moderation 
configuration and run the tool to overwrite the existing moderation configuration for the selected 
layer and moderation list. 

  To add a new moderation configuration, click the Add New button and continue with the following 
steps. 

• Choose the moderation list to use to process the features in the selected layer. 

• Choose the fields that will be scanned for content that matches the words and phrases in the 
selected moderation list. 

• Optionally, provide an SQL query to only apply moderation to some features. 

  If no query is provided, all features are processed. 

• Use the Field to Update parameter when a match is found between the value of a field and the 
content of a moderation list. Use the Found Value parameter to specify the value that should be 
written to this field indicating a match. 

• Click Run. 

Send email notifications 

Many workflows require that an email be sent when a feature or record is created and updated. You can 
use the Send Emails tool to configure emails that can be sent based on attribute values and a schedule 
of your choosing. The tool only generates the configuration; you must run an additional script (provided) 
to actually generate and send the emails. 

• In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

• Double-click the Send Emails tool. 

• In the Layer parameter, click Browse. 

  The Layer dialog box appears. 

• Under Portal, click My Content. 

• Double-click the Citizen Problem Reporter folder. 

• Double-click the CitizenProblems feature layer. 
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• Click Citizen Problems, and click OK. 

  All existing email settings for the layer load and can be edited by updating the parameter values for 

each configuration. To delete a single email configuration, click the Remove button  next to the 
configuration. To delete all the email configurations for the layer, check the Delete all existing 
email configurations for this layer check box. Run the tool to save your changes. 

• In the Email Template parameter, click Browse to access the ServiceSupport folder. 

• Click one of the HTML templates for the body of the email, and click OK. 

  To add attributes from the triggering feature to the email, use unique string keys in the places 
where the values should appear in the HTML and reference these strings in the Find parameter of 
the Email Substitutions section of the General Email Settings along with the name of the field that 
contains the value to be substituted for the string key in the Replace parameter. 

• Optionally, in the SQL Query parameter, provide an SQL query to only trigger an email from 
specific features. 

  If no query is provided, all features trigger emails every time the script is run, so you most likely 
want to use this query along with the Field to Update and Sent Value parameters to ensure that 
the same email isn't sent repeatedly for the same feature. 

• In the Recipient Email Address parameter, type an email address of the recipient or the name of a 
field in the layer that contains the address of the recipient. 

• In the Email Subject parameter, type the subject for the email. 

  Similar to the email body provided in the HTML document, this text can contain string keys that 
will be swapped out for attribute values based on the Find and Replace values defined in the Email 
Substitutions list in the General Email Settings section. 

• In the Field to Update parameter, type Email. When the email has been sent for each feature, use 
the Sent Value parameter to specify the value that should be written to this field indicating that 
the email has been sent. 

  This field and value can be used in the previously described SQL query to prevent duplicate emails 
from being sent. 

• Configure additional emails to be sent for the currently selected layer by clicking the Add New 
button. 

  Emails will be sent in the order they are configured. Expand General Email Settings. If the tool has 
not been run previously, start by specifying the connection information for your SMTP server in the 
tool. 

• In the SMTP Server parameter, type the URL of the SMTP server used for sending emails. 

• In the SMTP Username parameter, type the user name required to authenticate to the SMTP 
server. This is not required if authenticating through a port. 

• In the SMTP Password parameter, type the password required to authenticate to the SMTP server. 
This is not required if authenticating through a port. 

• In the From Address parameter, type the address from which the emails should be sent. 
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• In the Reply Address parameter, type the address that should be used for any replies to the email 
message. 

• Check or uncheck the Use TLS check box to turn on or off TLS. 

• In the Email Substitutions section, type Find and Replace values. Swap out one piece of text for 
another in the outgoing email subject or body.  

  Anywhere a value in the Find parameter is found in the email subject or body, it will be replaced 
with the corresponding value from the Replace parameter. If the value in the Replace parameter is 
a field in the layer, the Find value will be replaced with the value in that field in the triggering 
feature. For example, to add the ID of a feature from the REQUESTID field to the email subject, 
include a piece of text such as {ID} in the configured Email Subject, and add {ID} to the Find 
parameter and REQUESTID to the Replace parameter. All specified substitutions are applied to all 
emails configured for all layers so, while the Find values can be any piece of text, it's suggested that 
you use something that is clearly variable-like and unlikely to appear elsewhere in the messages in 
a literal form. 

  Deleting or changing these settings impacts all the emails for all the layers configured with this 
tool. 

• Click Run. 

Enrich reports 

Reports made in public comment apps can be enriched with information about the report location. You 
can then use this information to efficiently direct the report to the correct person or agency responsible 
for its resolution. 

You can then use the Enrich Reports tool to configure which attribute values to calculate from a 
coincident or intersecting set of features at a regularly scheduled interval of your choosing. Note that 
the tool only generates the configuration; you must run an additional script (provided) to update the 
features based on intersecting features. 

• In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

• Double-click the Enrich Reports tool. 

• In the Layer parameter, click the browse button. 

  The Layer dialog box appears. 

• Under Portal, click My Content. 

• Double-click the Citizen Problem Reporter folder. 

• Double-click the CitizenProblems feature layer. 

• Click Citizen Problems, and click OK. 

• In the Enrichment parameter, if an enrichment configuration already exists for the selected layer, 
choose to either edit an existing configuration by selecting the configuration from the drop-down 
list, or choose the option to add a new enrichment configuration. 

  If you choose to edit an existing configuration, a check box appears that, when checked, deletes 
the existing enrichment configuration for the selected layer. Alternatively, edit the configuration 
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and run the tool to save the changes. To add a new enrichment configuration, click the Add New 
button and continue with the following steps. 

• Choose the polygon feature layer that will provide the enriching attribute values by either choosing 
a layer from the active map or by browsing to your hosted content and choosing a polygon feature 
layer. 

• In the Source Field parameter, click the drop-down arrow and choose a field from the enrichment 
layer. 

• In the Target Field parameter, click the drop-down arrow and choose a field from the 
CitizenProblem feature layer. 

  The script does not process features that already have a value in the target field. 

• In the Priority parameter, type a value. Specify the priority for this enrichment configuration 
relative to the other configurations for the CitizenProblem feature layer. 

  Enrichment configurations for a layer that have a lower priority value will override enrichment 
configurations with a higher value. For example, a layer has two enrichment configurations that 
use the same target field, but one has a priority value of 1 and the other has a priority of 2. If the 
configuration with priority 1 does not produce a valid value for the field, the field is populated with 
the value produced from the configuration with priority 2. 

• Click Run. 

Set up Task Scheduler 

Use Windows Task Scheduler to schedule the script to generate report IDs when a feature or record is 
created, moderate reports when feedback contains inappropriate language, send email notifications 
when a feature or record is created or updated, or enrich reports. All the tools in this toolbox share a 
common configuration file and execution script, so only one scheduled task is required to automate 
running all the associated processes. 

• Open the Task Scheduler on the computer that is hosting the scripts. 

• Click Action > Create Task and name your task. 

• Click the Action tab and click New. 

• Set Action to Start a Program. 

• Browse to the location of your Python 3 installation (for example, <default 
directory>\C:\Program Files\ArcGIS\Pro\bin\Python\envs\arcgispro-
py3\python.exe). 

• In the Add arguments text box, type the name of the script (servicefunctions.py). 

• In the Start in text box, type the path to the folder where your script is and click OK. 

• Click the Trigger tab, click New, and set a schedule for your task. 

• Click OK. 

When the trigger occurs, the scripts begin scanning the configured layers and, for each one, processing 
(in order) configurations for generating identifiers, enriching reports, moderating reports, and sending 
emails. 
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Use Citizen Problem Reporter 

The Citizen Problem Reporter solution delivers a set of capabilities that help you solicit reports from the 
public, manage the response to each report, solicit feedback from the public after addressing a report, 
and monitor the resolution of non-emergency reports in a community. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing the 
workflows below. 

Note: 

Use the links below to try the apps with sample data provided by Esri, or use the workflows as a guide 
for using your own configured apps. 

Submit nonemergency problem reports 

You will first assume the role of a concerned resident in the community and would like to notify the city 
of a burned-out light in the park. 

• In a browser, go to the Citizen Problem Center site. 

• Scroll to the Report a Problem section and click the Submit a Report button to open the Citizen 
Problem Reporter app. 

• On the Citizen Problem Reporter page, click Proceed as Guest. 

• Click Park / Tree Problems. 

• Click Submit Problem. 

• For Type of Problem, choose Light Out. 

• In the Report a problem form, provide the issue details and your name, phone number, and email 
address. 

• Click the Where is the problem located text box and click the location of your broken park light on 
the map. 

• To submit your problem, click Report It. 

• At the top of the Park or Tree Problems form, click the Back button. 

• At the top of the list of problems, click your Light Out problem to select it. 

  The park light problem you reported appears. As the report moves through its life cycle 
(Submitted, Received, In Progress, and Completed), the status bar updates. 

• Optionally, click Leave a reply to display the comment form and add a new comment. 

You and others can add comments to update or highlight information related to the initial problem 
reported to authorities. 

Respond to problem reports 

You are now an employee for the city who is responsible for responding to submitted problem reports, 
assigning them to the appropriate department for resolution. 

• In a browser, go to the Citizen Problem Manager app. 
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• In the app, click the Category column filter. 

• Click Category is drop-down arrow and choose Park/Tree. 

• Click the Type of Problem column filter. 

• Type Light Out in the Type of Problem is text box. 

• In the Problems table, identify and click the problem you reported. 

  Review the details of the problem in the lower left corner of the app. 

•  On the Details tab, click the Edit button . 

• Click the Status drop-down arrow and choose Received. 

• Click Save. 

  Utility workers are ready to address the problem. 

• On the Details tab, click the Edit button. 

• Click the Status drop-down arrow and choose In Progress. 

• Click the Assigned To drop-down arrow and choose Utility. 

• Click Save. 

  Utility workers inform you that the park light bulb has been replaced. 

• On the Details tab, click the Edit button. 

• Click the Status drop-down arrow and choose Completed. 

• For Resolved On, choose the current date. 

• In the Resolution text box, type Park light bulb has been replaced. 

• Click Save. 

  Once the issue is complete, the status indicator changes and the details now provide information 
about when and how the issue was resolved. 

• In the Details tab, click the Send Satisfaction Survey button. 

• Review the formatted email and send it to yourself. 

Provide feedback on work performed 

In the previous section, you sent yourself an email containing a link to a satisfaction survey. You will now 
respond to the survey as the resident who originally submitted the problem report with your feedback 
on how the issue was handled. 

• Open the email you sent to yourself in the previous section. 

• Click the URL in the email to open the Citizen Satisfaction Survey. 

• In the app, complete the first four survey questions. 

• Optionally, for Do you have any other comments or concerns, add any other comments. 

• For Would you like to be contacted for more information, click Yes. 
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• Provide information for the Full Name, Phone, and Email parameters. 

• Click Submit. 

Monitor reports and measure performance 

As a program manager for the city, you want to know how well the citizen problem program is 
functioning, monitor the reports coming in, and see how satisfied the residents are with the program. 

• In a browser, go to the Citizen Problem Dashboard app. 

• On the Overview tab, review the high-level metrics. 

  The Overview tab displays infographics of categories of reported problems. This information gives 
management a quick overview of the number of reported problems submitted by the public. 

• Click the Problem Reports tab at the bottom of the dashboard. 

  The Problem Reports tab allows a department manager to monitor how their department is doing 
when it comes to resolving problems. The page displays the top problem types and categories and 
summarizes reports by month with details. 

• Use the graphs to filter and explore active and resolved problem reports. 

  Dashboard charts are linked. As you click and select a category in one chart, related details are 
filtered and updated in other charts on the report to allow a manager to identify issues and areas 
that need attention. 

• Click the Survey Results tab at the bottom of the dashboard and explore the survey responses. 

  The Survey Results tab displays the results from the Citizen Satisfaction Survey. The indicators on 
the tab include Resolution Quality, Resolution Time, and Customer Service indicators that identify 
whether a community is below or above its target. 

  The Recommended Problem Reporter to Friend or Colleague chart is used to display whether the 
person who submitted the survey would recommend using the Citizen Problem Reporter to a 
friend or colleague. The right side of the dashboard displays the number of surveys submitted and 
their details. 

• Locate your response in the Surveys list and click it to see the details. 

• Click the arrow on the left of the app to display additional filters. 

• Use the filters in the left panel to explore survey results by date, category, problem type, 
resolution time and quality, and customer service experience feedback. 

  You can filter by Submission Date, Category, and Type of Problem. In addition, you can filter out 
information related to the Resolution Quality, Resolution Time, and Customer Service Experience. 
These are indicators of overall success, user satisfaction, effectiveness, and public support. 

Volunteer in the community 

As an engaged resident of the community, you would like volunteer to help keep the community clean, 
healthy, and safe. You will fill out a survey to provide your interests, skills, and availability so the city can 
help connect you with volunteer opportunities. 

• In a browser, go to Citizen Problem Center site. 
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• Scroll to the Volunteer in Your Neighborhood section and click the Volunteer button to open the 
Volunteer in Your Neighborhood survey. 

• Complete the Volunteer in Your Neighborhood survey and click Submit. 

 


